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1. Installation 
 

a) Make sure you have installed and updated Igor to the latest version 
(6.20B02 on Mac or 6.2.1 on Windows). 

b) Download pFLIM.zip as well as TabControl 
(http://www.igorexchange.com/project/ACL_tabcontrol) and 
multiopenfiles (http://www.igorexchange.com/project/multiopenfiles). 

c) “pFLIM.ipf”, “ACL_TabUtilities.ipf”, and “ACL_Tab Control Utilities.ihf” 
should be saved in 
 My  Documents/WaveMetrics/Igor Pro 6 User Files/User Procedures 

d) “pFLIM.xop”, “multiopenfiles.xop”, and “multiopenfile Help.ihf” should be 
saved in 
 My  Documents/WaveMetrics/Igor Pro 6 User Files/Igor Extensions 
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2. Running the program 
 

a) If Igor is already open, exit Igor. 
b) Either 

 Double-click pFLIM.ipf, which automatically starts Igor, or 
 Start Igor by clicking on its icon, then go to the File pulldown menu: 

(1) Open File -> Procedure, or 
(2) Recent Files, if you had opened pFLIM.ipf previously. 

c) Macros -> Compile. 
d) A new menu item, “FLIM” will appear. 
e) FLIM -> Initialize Analysis.  This will hide the .ipf file and will open the 

User Panel. 
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3. Loading Data 
 

a) Make sure that all folders in the pathname to your .pt3 files as well as the 
actual filenames do not contain: “+” or “–“ signs or other unusual 
characters (keep it to letters, numbers and “_”) and are not too long.  
If the program crashes this is likely the source of the problem.  

b) On the User panel click on Select Arrival-Time File. In the following 
dialogue select the .pt3 files you want to analyze. Once you click “ok”, you 
have to wait a bit. In this time, the program scans through the .pt3 file and 
retrieves general file information, like the size of the image, the total 
counts, etc. This will then be displayed in the fields on the Load tab of the 
User panel. Also make sure that the correct file path and name is 
displayed in the window at the top right of the panel.  If parts are 
missing there was a problem with the naming of the folders and files (see 
3a). 

c) Now is a good time to save the experiment. If there is any problem with 
the file names, the program will crash in the next step! 

d) You can view all the files names you selected: 
 Open the data browser: Data -> Data Browser. 
 Double-click root:Data:FileTable. 

e) Now go to the latest dataset you loaded (increase the number in Show 
with the arrows or use the up key until you reach the end). Be aware, if 
you loaded 10 datasets, Show will only go to 9 because it starts at 0. 

f) Now change the number displayed in from dataset to 0 (Create 
Histograms box on the Load tab. 

g) Save the experiment. 
h) Click Create Histograms button. The program now scans through the .pt3 

file to create the time histogram. 
i) Make sure to never move the .pt3 files!  The Igor experiment has its 

locations stored and needs to access the .pt3 file during the image 
processing.  So if you move the files, Igor won’t be able to find them any 
more! (If you really need to move your files you can replace the file 
location in the FileTable wave).  

j) Once Igor is done calculating the histograms, save the experiment. 
k) Now you can either continue by analyzing the histogram (continue with 

(4)) or by creating the Intensity image (if you want to select ROIs to select 
certain cells and recalculate the histogram) (continue with (5)). 
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4. Analyzing the histograms 
 

a) For a donor sample, you probably want to use a single-exponential, so go 
to the Single tab. 

b) For a donor + acceptor sample, go to the Double tab. 
c) If your donor is already double-exponential you might want to try to fit 

the donor + acceptor data with a triple-exponential fit.  However, you can’t 
do any image analysis with triple-exponentials yet. 

d) Now you want to adjust the starting values for the Igor fit: 
 S defines the height of the red curve (your “Start Values for Fit”) and 

should be close to the number of photons in the histogram (see the 
Load tab). This value is automatically transferred when you created 
the histogram. Meaning, you shouldn’t have to change it at all.  

 Adjust tg until the initial rise of the histogram of the black and the red 
curves roughly correspond. 

e) With these starting values Igor should be able to fit the curve 
automatically, so click Fit (on the Single, Double, or Triple tab) in the User 
panel.  An orange curve showing the result of the fit will appear in the 
graph. 

f) If the fit was successful, click the Apply Fit Results button. This will copy 
the values from the fit to the “Start Values for Fit” part of the User panel. 
You will also see that the red curve will now overlap the orange curve (so 
you don’t see the orange curve any more).  

g) If the fit was not successful (you don’t like it or even got an error message) 
DON’T click the Apply Fit Results button. Just change the “Start Values for 
Fit” and try again. 

h) It CAN happen that the limits I put on the parameters are too narrow. If 
you see that a fit results in one of the parameters reaching its limit (upper 
or lower) try increase or decreasing this limit and repeat the fit. At some 
point the fit will converge (the button Cont. Fit keeps fitting the data until 
2 does not significantly decrease any longer). 

i) Make sure that the IRF always stays reasonable. You can see its 
components in the top part of the TimeHist graph. If you don’t know how 
an IRF should look, you can contact me. 

j) Again, I recommend you first analyze all histograms before continuing 
with the single-pixel analysis. 
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5. Single-pixel Analysis 
 

a) This is done in the sub-tab Pixel Analysis (only available for single- and 
double-exponential fits). 

b) First we want to create the Intensity image. 
c) This is done by checking Preprocess (and unchecking Single Lifetime on 

the Single tab or Double Lifetime on the Double tab). 
d) If you want to bin the image (e.g. 2x2 or 4x4) change this accordingly. 
e) Again, select all datasets by setting the value of Analyze dataset to 0 and to 

to the last dataset loaded. 
f) Save the experiment. 
g) Click the Start button. 
h) This will again take some time, quite some time. The program sorts the 

.pt3 file by pixel x, pixel y and the relative arrival time, taking into account 
any binning.  The result is saved as a binary .bin file. Finally, the intensity 
image is created. 

i) Once this is accomplished, you can continue the single-pixel analysis. 
j) For the single-pixel analysis, the values shown in the Start values for 

Fit part of the panel will be used.  That’s why it’s important to 
remember to press the Apply Fit Results button after a successful fit. 

k) Uncheck Preprocess and check Single Lifetime or Double Lifetime. 
 

 
 

l) Again click the Start button. 
m) In general, you can do the Preprocessing and the Single/Double lifetime 

analysis in one go. For this, just check both boxes. This is useful if you will 
be away from the computer for a while. 
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n) The program now creates and displays the following images for double 
exponential lifetime analysis: 
 Alpha image: this is probably what you are interested in as everyone 

always talks about .  = (/2) / ( (1-)/1 + /2 ), where  tells you 
what fraction of the signal photons came from the second lifetime (e.g. 
a value of 0.2 means that 20% of the signal photons came from 2 while 
80% came from 1). 

 Average tau image: Avg  = (1-) * 1 +  * 2 
 In addition you get these images weighted by the signal image. 

o) In addition the program creates but does not by default display the 
following image: 
 Signal counts image: how many of the photons in each pixel came from 

the actual fluorophores (as opposed to background). 
p) You can choose which images to display by clicking Display Options under 

the FLIM menu. Then check or uncheck the appropriate boxes. 
q) In addition, you can create the following images through the FLIM menu: 

 Background counts image: how many of the photons in each pixel 
came from background (if you add the signal counts image to this you 
would get the intensity image). 

 Beta image.  
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6. Movies 
 

a) If you want, you can split up the data to make frames in a movie (e.g. you 
took data over 30 min but want to make a movie with 5 min frames).  This 
will create sequences of images, which you can look at using the slider 
that will automatically appear above each image (e.g. each individual 
image would cover 5 min, and since you took data for 30 min, there will be 
a sequence of 6 images).  

b) In the Time-course section of the Pixel Analysis sub-panel you can see 
how many frames you took when acquiring the data.  You can also see 
how long it took to scan through each frame (this was set by you through 
the scanning speed). By changing the variable Window (Frames) you can 
choose how many frames to analyze together. If the value is 0 (default) the 
program will analyze the whole data set together as one frame.  

c) Note: if there are 10 frames (0 to 9) and you choose to analyze 3 frames 
together (e.g. 0-2, 3-5, 6-8) there will be one frame (9) left over at the end. 
This frame is therefore not included in the movie! 
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7. ROIs 
 

a) For the single-pixel analysis ROIs are irrelevant since you anyway look at 
each pixel separately.  The time-histogram on the other hand by default 
includes ALL photons that arrived anywhere in the image.  So this you 
might want to change if, for example, you wish to exclude a bright dead 
cell that would otherwise "contaminate" your total arrival histogram. 

b) There are 2 ways to create an ROI: 
 Manually drawing an ROI 

(1) Go to the ROI tab. 
(2) Click Create ROI.  This will open a new small panel. 
(3) Click on the graph you want to create the ROI on (probably the 

Intensity image).  
(4) Click Start ROI Draw in the new panel. 
(5) On the chosen image, there will be tools appearing on the left side. 

Choose which type of shape you want to create (you can combine 
several) and start drawing. 

(6) When you are done, click Finish ROI.  The ROI(s) will now be shown 
in green. 

(7) Click Save ROI Copy. 
(8) Click Erase ROI, which erases the ROI from the image (it’s saved 

though). 
 Creating an ROI by thresholding an image 

(1) Select the Intensity or Signal image 
(2) Go to the menu Image, then Threshold 
(3) In the new window that opened choose the range between min and 

max that you want to include in your ROI (e.g 20 to Inf). 
(4) Choose When done: New Image 
(5) Done 
(6) A new image with your ROI appears, just close it 
(7) In the ROI tab, click Copy threshold ROI 

c) In the list of ROIs on the user panel, a new ROI has appeared. 
d) If you want, you can now create another new ROI, just follow the 

instructions above. 
e) To display your saved ROIs, just select them in the list on the User panel.  

It will be display on the intensity graph, the white parts will be excluded, 
the transparent parts included. 

f) To recalculate the histogram from the selected parts of the image, just 
click Recalculate Histogram.  This again takes a moment (not too long). 

g) Now you can re-fit the new histogram (the old one is overwritten!!) and 
see if you can get a better fit. 
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8. Pretty Layout 
 

If you want to print or externally save (as pdf…) the results for a dataset, you 
can use the PrettyLayout function listed under FLIM.  This assumes that you 
currently display all necessary graphs (open Display Options) created with 
the double-exp analysis (otherwise there will be empty spots on the layout). 
The source code (Windows -> Procedure Windows -> pFLIM.ipf, then search 
for PrettyLayout) can also serve as a template for your own layouts. 
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9. Location of relevant waves and images within the Igor 
experiment (as seen in the Data Browser) 

 
 root 

 Data 
 FileInfo_Variables information displayed on the Load tab of the  
 FileInfo_Strings  user panel** 
 FileTable   complete pathname and filename of .pt3 files 

    you selected 
 hist_0   Time histograms 
 hist_1 
 ... 

 Analysis 
 Manual 

 TrialValuesIRF** start values for the IRF fit 
 TrialValuesSingle** start values for the Single fit 
 TrialValuesDouble** start values for the Double fit 
 TrialValuesTriple** start values for the Triple fit 
 IRF 

 IRFInit_0  waves shown in TimeHist graph  
 IRFInit_1  corresponding to the values displayed in the 

...   Start Values section of the IRF tab 
 Single 

 SingleInit_0 waves shown in TimeHist graph  
 SingleInit_1 corresponding to the values displayed in the 

...   Start Values section of the Single tab 
 Double 

 DoubleInit_0 waves shown in TimeHist graph  
 DoubleInit_1 corresponding to the values displayed in the 

...   Start Values section of the Double tab 
 Triple 

TripleInit_0 waves shown in TimeHist graph  
 TripleInit_1 corresponding to the values displayed in the 

...   Start Values section of the Triple tab 
 Fits 

 FitValuesIRF** results of the fits to the time  
 FitValuesSingle** histograms 
 FitValuesDouble** 
 FitValuesTriple 
 IRF 

 IRFFit_0  waves shown in TimeHist graph  
 IRFFit_1  corresponding to the result of the IRF fit for  
 ...   each data set 

 Single 
 SingleFit_0 waves shown in TimeHist graph  
 SingleFit_1 corresponding to the result of the Single fit  
 ...   for each data set 

 Double 
 DoubleFit_0 waves shown in TimeHist graph  
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 DoubleFit_1 corresponding to the result of the Double fit  
 ...   for each data set 

 Triple 
 TripleFit_0 waves shown in TimeHist graph  
 TripleFit_1 corresponding to the result of the Triple fit  
 ...   for each data set 
 

 Pixels   all images created by the single-pixel analysis 
 Intensity_B1_0 Intensity image of dataset 0 binned 1x1 
 Signal_B1_0  Signal image of dataset 0 binned 1x1 
 pScore_B1_0  pScore image of dataset 0 binned 1x1 
 AvgTau_B1_0  avg image of dataset 0 binned 1x1 
 Alpha_B1_0   image of dataset 0 binned 1x1 
 AvgTau_B1_W_0 avg image of dataset 0 binned 1x1, weighted 

   by signal image 
 Alpha_B1_W_0  image of dataset 0 binned 1x1, weighted by 

   signal image 
 Intensity_B2_0 Intensity image of dataset 0 binned 2x2 
 Intensity_B1_1 Intensity image of dataset 1 binned 1x1 
 ... 

 ROIMask everything related to the ROIs 
 ROIMask1_0  1st ROI Mask created for dataset 0 
 ROIMask2_0  2nd ROI Mask created for dataset 0 
 ROIMask1_1  1st ROI Mask created for dataset 1 

 
** Double-click these waves to display them in a table, then go to Table -> 
Horizontal Index -> Dimension Labels. In the table this changes the display of the 
horizontal point number (0, 1, 2, …) to a label of the column that will tell you 
what value is displayed in each column.  The rows stand for each dataset (e.g. the 
values of dataset 0 are shown in row 0, and so on). 
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